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Disclaimer: This guide is not meant to present you with all the answers to your problems. There are
so many containers/codecs and other factors that will determine your best choice of codec. This guide
is merely meant to educate you so that you understand the terminology and will be able to select the
codec that best fits your needs.
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I. What is a Video Format?
Video formats involve two distinct, and very different technology
concepts: containers (sometimes called wrappers) & codecs (short for coder/decoder).
Codecs are used inside of a container and because of this video formats can be confusing.

A. What is a Container?
The container describes the structure of the file: where the various pieces are stored,
how they are interleaved, and which codecs are used by which pieces. It may specify
an audio codec as well as video. It is used to package the video & its components
(audio/metadata) and is identified (usually) by a file extension such as .AVI, .MP4 or
.MOV. See Appendix B for list of Containers

B. Whatis a Codec?
A codec (short for "coder/decoder") is a way of encoding audio or video into a stream
of bytes. It is the method used to encode the video and is the chief determiner of
quality. See Appendix B for list of Codecs

C. How do they work together?
Think of the container as the file itself. Think of the codec as its contents. The
important thing to realize is that most good container formats can hold many codecs.
For example a .MOV container can hold almost any kind of codec data. The same goes
for .MP4 and even .AVI files can hold a wide variety of codecs as their contents. In no
way does the container decide the quality or features of the video itself, that is up to
the codec. The proper way to describe video is to indicate both: A.MOYV file
containing H.264 data. An .AVI file containing DivX data. Professionals use
shorthand’s for this, saying things like "Give me an H.264 Quicktime file (.mov)".

D. Whyis it so complicated?
At first this seems straightforward, but it's not. The problem lies in the confusion and
imprecision in the common use of these terms. To make matters worse, software
companies try to simplify their documentation and instructions by ignoring the
difference altogether. The result is that people believe that phrases like "I'll give you a
MOV file," or "An MP4 file will be fine" are legitimate ways to talk about video.

To make life even more confusing, some names, such as "mpeg-4", describe both a
codec and a container, so it's not always clear from context, which is being used. You
could have a movie encoded with an mpeg-4 codec inside an avi container, for
example, or a movie encoded with the Sorenson codec inside an mpeg-4 container.

Content compiled from Matt Buchanan of Gizmodo.com at http://gizmodo.com/5093670/giz-explains-every-video-
format-you-need-to-know
&

http://www.shallowsky.com/linux/videoformats.html




II.
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What Video Format Should I Use?
File size & quality

A.

1.

Digital Storage Space - To calculate the amount of storage space you will
need for a project, digital video requires approximately 200 MB per minute of
footage, or roughly 12 GB per hour. Of course this varies according to your
recording device and the quality it is set to record at.

Frames per Second — The standard for FPS is 29.97, increasing the FPS allows
for more images per second thus a smoother image. Decreasing FPS will
make the video a bit choppy and not nearly as smooth.

Video Bitrate - Bitrate is a measurement of the number of bits that are
transmitted over a set length of time. Your overall bitrate is a combination of
your video stream, audio stream & metadata in your file with the majority
coming from your video stream. The higher the bit rate the better the quality
the bigger it will be.

Resolution — this is the number of pixels present in the images of the video.
This determines whether your video is standard definition or high definition.
The higher the resolution the clearer the image the bigger the file.
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B. Transmitting the media: deciding what codec you want to use depends on your
means of transmitting the video so others can view it. This could be an external hard
drive, jump drive, via email or uploading to a social media website/blog.

See Appendix for instructions in uploading video to common websites.

C. So what codec should | use? (see appendix for type of codecs and what they are
typically used for)

1. Check the requirements from the Internet sites you wish to upload your video
file. (Much of the internet supports a MP4 container with a H.264 codec)
see appendix for specific media site requirements

2. Is your video meant for mobile applications? If so, select a codec that
supports all mobile devices (ex. Apple does not support flash videos)

3. Isyour video going to be embedded in another application? What other
applications will typically do is take the video and apply their own codec to
the video so that it will be playable within their application but that does not
mean the application will understand all types of codec. Check the
applications help menu to determine the best codec for importing.

III. How do I get it to play on any computer?
It is nearly impossible to get it to play on every computer b/c it all depends on the viewer
and what type of decoder their computer may have. Mac and Windows are notorious for
having their own containers/codecs and viewers have difficulty watching it on there
respective choice of hardware. To play Windows Media Files (WMV) on macs you need to
install Flip for Mac and to play on a PC, VLC (also available for Mac) is a free video player
that plays almost every kind of video codec. You may also have to download other
decoders to play different video formats on a Windows Media Player. Visit link below for
more information on codecs for Windows Media Player.
http://windows.microsoft.com/en-US/windows7/Codecs-frequently-asked-questions

Content compiled from Matt Buchanan of Gizmodo.com at http://gizmodo.com/5093670/giz-explains-every-video-
format-you-need-to-know
&

http://www.shallowsky.com/linux/videoformats.html
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APPENDIX

A. List of Most Common Codecs

MPEG (Moving Pictures Expert Group): three video formats, MPEG 1, 2, and 4.

MPEG-1: Old, supported by everything (at least up to 352x240), reasonably efficient. A
good format for the web.

MPEG-2: A version of MPEG-1, with better compression. 720x480. Used in
HDTV, DVD, and SVCD.

MPEG-4: A family of codecs, some of which are open, others Microsoft proprietary.

H.264: Most commonly used codecs for videos uploaded to the web. Part of the MPEG-4 codec.

MPEG spinoffs: mp3 (for music) and VideoCD.

MJPEG (Motion JPEG): A codec consisting of a stream of JPEG images. Common in
video from digital cameras, and a reasonable format for editing videos, but it
doesn't compress well, so it's not good for web distribution.

DV (Digital Video): Usually used for video grabbed via firewire off a video
camera. Fixed at 720x480 @ 29.97FPS, or 720x576 @ 25 FPS. Not very highly
compressed.

WMV (Windows Media Video): A collection of Microsoft proprietary video

codecs. Since version 7, it has used a special version of MPEGA4.

RM (Real Media): a closed codec developed by Real Networks for streaming video and

audio.

DivX: in early versions, essentially an ASF (incomplete early MPEG-4) codec inside an
AVI container; DivX 4 and later are a more full MPEG-4 codec...no resolution
limit. Requires more horsepower to play than mpegl, but less than mpeg2. Hard
to find mac and windows players.

Sorenson 3: Apple's proprietary codec, commonly used for distributing movie trailers
(inside a Quicktime container).

Quicktime 6: Apple's implementation of an MPEG4 codec.

RP9: a very efficient streaming proprietary codec from Real (not MPEG4).

WMV9: a proprietary, non-MPEG4 codec from Microsoft.

Ogg Theora: A relatively new open format from Xiph.org.

Dirac: A very new open format under development by the BBC.

B. List of Most Common Containers
AVI (Audio Video Interleave): a Windows' standard multimedia container.
MPEG-4 Part 14 (known as .mp4): is the standardized container for MPEG-4.
FLV (Flash Video): the format used to deliver MPEG video through Flash Player.
MOV: Apple's QuickTime container format.
OGG, OGM & OGV: open-standard containers.
MKV (Mastroska): another open-specification container that you've seen if you've ever
downloaded anime.
VOB (DVD Video Object): It's DVD's standard container.
ASF: a Microsoft format designed for WMV and WMA—files can end in .wmv or .asf

Content provided by http://www.shallowsky.com/linux/videoformats.html
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C. Sample Bit Rates

16 kbit/s — videophone quality (minimum necessary for a consumer-acceptable “talking head”
picture using various video compression schemes)

128 — 384 kbit/s — business-oriented videoconferencing quality using video compression

1.5 Mbit/s max — VCD quality (using MPEG1 compression)

3.5 Mbit/s typ — Standard-definition television quality (with bit-rate reduction from MPEG-2
compression)

9.8 Mbit/s max — DVD (using MPEG2 compression)

8 to 15 Mbit/s typ — HDTV quality (with bit-rate reduction from MPEG-4 AVC compression)
19 Mbit/s approximate — HDV 720p (using MPEG2 compression)

24 Mbit/s max — AVCHD (using MPEG4 AVC compression)

25 Mbit/s approximate — HDV 1080i (using MPEG2 compression)

29.4 Mbit/s max — HD DVD

40 Mbit/s max — Blu-ray Disc (using MPEG2, AVC or VC-1 compression)

Content provided by http://en.wikipedia.org/wiki/Bit_rate#Video
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D. Encoding in iMovie, Final Cut Pro, and QuickTime Pro for YouTube

Audio/Video issues with .MOV and .MP4. How to ensure proper Audio/Video sync through a QuickTime conversion.

MOV/MPA4 files exported from programs such as iMovie, Final Cut Pro, and QuickTime Pro have certain elements that are
not handled well by YouTube transcoding. In order to ensure optimal upload quality—and specifically that the Audio and

Video of the file remain in sync—use the encoding settings outlined below.
Export your video using QuickTime
* IniMovie, select Share > Export Using QuickTime
* In Finalcut Pro, select File > Export > Using Quicktime Conversion > Options
* In QuickTime Pro, select File > Export > Export: Movie to QuickTime Movie > Options

Alter your video encoding

1. Enter a name for your file, and select Movie to QuickTime Movie from the Export dropdown.
Save exported file as... |

Save As:  upload.mov ] @

\ Where: | (& Desktop )
Export: (-Movie to QuickTime Movie ﬂ ( Options...
| :i

Use: [ Most Recent Settings

Cancel ) @

2. Click Options and make the following changes to Video settings:

o Compression Type: H.264
o Frame Rate: 30 is preferred. 23.98, 24, 25, 29.97 are also acceptable.
o Data Rate: Automatic
o Key Frames: Automatic
o Frame Reordering: Unchecked
s d Video C Setting Sound Settings
Compression Type: | H.264 2
Motion Data Rate Format: [ AAC 3
Frame Rate: 30 ] fps Data Rate: ) Automatic

() Restrict to kbits/sec Channels: [ Stereo (L R) =

Key Frames: () Automatic

() Every frames Optimized for i ; Rate: 48.000 @ kHz

QA
Frame Reordering @ Show Advanced Settings
Comprassor Rrenee Render Settings:
Quality
@ - Quality: | Normal } 3]
P ~ Ty .
oL LR * MPEG 4 AAC LC Encoder Settings:
_ Encoding Strategy: | Constant Bit Rate ¥
Encoding: (@ Best quality (Multi-pass) q
() Faster encode (Single-pass) Target Bit Rate: | 128 ﬂ kbps

Preview ["] Play Source
@ (o) @ Cancel
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3. Make the following changes to Audio or Sound settings:
o Format: AAC
o Click Show advanced settings and choose Constant Bit Rate as encoding strategy.
Select Size and choose the original size of the video.
5. :I'he section Prepare for Internet Streaming must be set to Fast Start.

Movie Settings
E! Video
( Settings... ) Compression: H.264
S———"  Quality: Best

Encoding mode: multi-pass

(__Filter... ) Dimensions: 960x540 (Current)

| ———
( Size... )

Allow Transcoding

™ Sound
( Settings... ") Format: AAC
S Sample rate: 48.000 kHz

Channels: Stereo (L R)
Bit rate: 128 kbps

@ Prepare for Internet Streaming
| Fast Start T] Settings

Cancel ) ( oK )

6. Save your video, and then upload the resulting file to YouTube

All users have the ability to upload videos up to 15 minutes in length. You can attain the ability to upload longer
length videos if:

e Your account is in good standing, as determined by the YouTube Community Guidelines.
* You verify your account with a mobile phone.
* Your account has no worldwide Content ID blocks on any content

On the upload page, click the link to Increase your limit to be prompted to verify your account. If you do not
have the option to verify your account, or if you lose your access to long uploads, the best first step is to
check your account for copyright claims and strikes.

Content provided by
http://support.google.com/youtube/bin/static.py?hl=en&guide=1728585&topic=1728570&page=guide.cs




Video Formats

E. Encoding with Windows Movie Maker for YouTube

I’m using Windows Movie Maker. Why won’t my video upload?

If you are using Windows Movie Maker or Windows Live Movie Maker and experiencing errors with your
uploads, it is possible that you are attempting to upload a project file, which is not an actual movie file. You
can follow the simple steps outlined below to convert your video project to a .wmuv file, which is an acceptable
format for upload.

Windows Movie Maker: Converting . MSWMM

If you edited your video using Windows Movie Maker, you may have also attempted to upload a .MSWMM
project file. You can convert this project to .wmv format by following these steps:

Click File and then select Save Movie File from the dropdown. In the next step, select My Computer as your
saving destination, and then click next.

Save Movie Wizard (==
Movie Location “
Where do you want to save your movie to? .
@ project_file - Windows Movie Maker o ;
»‘aiﬂ»l EZ:’EE? r movie to a tape in your DV camera for playback on the camera or to watch o
Edit View Tools Clip Play Help S
[[] New Project Ctrl+N
o Open Project... Ctrl+0
! Il Save Project Ctrl+S
Save Project As... F12
Save Movie File... Ctrl+P
Import into Collections... Ctrl+I
Properties
3 1 C:\Users\dboyle\Desktop\project_file. MSWMM
=

Enter a name for your file, and then choose a place to save your movie. In the next step, click Next to start
encoding your video with default settings. If you would like to make more advanced adjustments to the file,
you may also select Show more choices

Save Movie Wizard (=) Save Movie Wizard (=
Saved Movie File Movie Setting "
Enter information for your saved movie file. Select the setting you want to use to save your movie. The setting you select
> determines the quality and file size of your saved movie. o
1. Enter a file name for your saved movie. © Best quality for playback on my computer (recommended)

Show more choices...
new-youtube-movie

2. Choose a place to save your movie.

B My Videos v | | Browse...
) ( )

Setting details Movie file size

File type: Windows Media Video (WMV) Estimated space required:
Bitrate: 896 Kbps 75MB

Display size: 720 x 480 pixels

Aspect ratio: 4:3 Estimated disk space available on drive C:
Frames per second: 30 74.62GB
[ <Back | Net> ] [ Cancel |

<Back [ Net> | [ Cancel




Video Formats

F. Recommended Compression Settings for Vimeo

Acceptable video formats include asf, asx, avi, divx, dv, dvx, m4v, mov, mp4, mpeg, mpg, qt, wmv, 392, 3gp,
3ivx and 3vx.

How do | upload a Video?

Go to the upload page. Or, you can click the ‘Upload Video’ button on the home page or find a link in the top navigation
bar under the heading ‘Upload’. That will bring you to the upload page where you can upload your video. Make sure you
have thoroughly read the rules for what kind of videos you can upload (only ones you make yourself!) and hit the ‘choose
a file to upload’ button, select the file you want to upload from your computer, and hit ‘Select’. Your video will magically
start uploading to our services and you will see a progress bar telling you how long it will take.

Note: slower connections and large files will take longer so please be patient.

After you video is finished uploading, it will go through a conversion process. You can monitor that process with a
progress bar as well. While the video is converting you may leave that page and Vimeo will send you an email when its
finished. Now that’s not too hard, is it?

Video Settings

Codec H.264

A codec is the format in which your video will be encoded. Different codecs have different
features and varying quality. For best results, we recommend using H.264 (sometimes
referred to as MP4).

Frame rate 24, 25, or 30 FPS

If you know at which frame rate you shot, it is best to encode at that same frame rate.
However, if it exceeds 30 FPS (frames per second), you should encode your video at half
that frame rate. For example, if you shot 60 FPS, you should encode at 30 FPS. If you're
uncertain what frame rate you shot at, set it to either "Current" or 30 FPS. If there is an
option for keyframes, use the same value you used for frame rate.

Data rate 2000 kbps (SD), 5000 kbps (HD)

This setting controls both the visual quality of the video and the file size. In most video
editors, this is done in terms of kilobits per second (kbps). Use 2000 kbps for standard
definition or 5000 kbps for high definition video.

Resolution 640x480 (SD), 1280x720 (HD)

640x480 for 4:3 SD video, 640x360 for 16:9 SD video, and 1280x720 or 1920x1080
for HD. If you have the option to control the pixel aspect ratio (not the display aspect ratio)
make sure it's set to "1:1" or "1.00", sometimes referred to as "square pixels."



Video Formats

Deinterlacing Maybe

If you are shooting on an older camera, enable this option. Otherwise, you may get weird-
looking horizontal lines in your video. With newer camera models this won't matter, so you
can leave this option unchecked.

Audio Settings

Codec AAC (Advanced Audio Codec)

For best results, we recommend using AAC for the audio codec.

Data rate 320 kbps

320 kbps is the highest quality audio data rate we currently support.

Sample 44 1 kHz

rate
44.1 kHz is the highest audio sample rate we currently support.

How many videos can | upload?

Basic account users can upload 500 MB a week (with a max of 10 files per day). Plus users can upload 5 GB
per week, and there is no per-day upload limit.

This quota resets weekly, and your personal reset day can be seen on the right side of the Upload Page,
along with how much space you have remaining this week. Videos that you upload remain on the site, so
you can upload 500 MB of videos this week, and another 500 MB next week, and they'll all be there for the
watching.

Are there limits on file sizes or file types for uploads?

There is a 5 GB per file limit for Plus users, which does not affect Basic account users.

We accept the following file types: asf, asx, avi, divx, dv, dvx, m4v, mov, mp4, mpeg, mpg, qt, wmyv, 3g2,
3gp, 3ivx and 3vx

Please note: There are a million variables in video compression. Sometimes, even though a file type is
accepted by the Vimeo uploader, the Vimeo conversion will fail.

Content provided by http://vimeo.com/help/compression & http://vimeo.com/fagfirecommended_settings
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G. Uploading Videos to Facebook

How do | add videos to Facebook?

1. Click Add Photo / Video at the top of your home page.

2. Pick Upload Photo / Video to select a video file you have on your computer. If you want to record a video from
your webcam, pick Use Webcam.

3. When your video is ready, click Post.

What formats of video files can | upload?

We support almost all video file types, but you'll have the best luck with theMP4 format. Here's the complete list:

3g2 (Mobile Video) = f4v (Flash Video) =  mpeg (MPEG Video) = tod (TOD Video)

3gp (Mobile Video) = flv (Flash Video) =  mpeg4 (MPEG-4 Video) = ts (MPEG Transport
3gpp (Mobile Video) = m2ts (M2TS Video) =  mpg (MPEG Video) Stream)

asf (Windows Media =  md4v (MPEG-4 Video) = mts (AVCHD Video) =  vob (DVD Video)
Video) =  mkv (Matroska Format) = nsv (Nullsoft Video) =  wmyv (Windows Media
avi (AVI Video) =  mod (MOD Video) = ogm (Ogg Media Video)

dat (MPEG Video) =  mov (QuickTime Movie) Format)

divx (DIVX Video) =  mp4 (MPEG-4 Video) = ogv (Ogg Video Format)

dv (DV Video) =  mpe (MPEG Video) = gt (QuickTime Movie)

The aspect ratio of the video has to be between 9x16 and 16x9, and the video cannot exceed the file size or length that
the upload page suggests.

How can | optimize the quality of my videos?

Generally, the best format to upload is H.264 video with AAC audio in MOV or MP4 format. H.264 currently offers the
best video compression available, and due to file size limitations, this format is the optimal choice for Facebook Video.

To avoid the rescaling of your video by Facebook's encoder, use a file with the larger edge of the video not exceeding
1280px. If your video is less than 1280px in size on the larger edge, try to keep your dimensions to multiples of 16px for
best compression.

Frame rate of the uploaded video will be roughly maintained with that of the original, with a maximum of 30fps (frames
per second). If the original video has a variable frame rate, we will try to maintain the average frame rate of the original. If
we cannot determine the frame rate of the original file, it will be forced to 30fps. Note that if a frame rate is to be
decimated, we will only ever decimate by whole integers. This may result in an original video with a relatively high frame
rate undergoing a frame rate conversion to below the maximum of 30fps. For example, if a video has a frame rate of
100fps, it will be decimated by a factor of 4, resulting in 25fps.

Audio-specific:

The number of audio channels will be maintained for stereo and mono streams. 5.1-channel audio will be down-mixed to
stereo. All other channel configurations are currently unsupported.

Audio will be re-sampled to either 22,050hz or 44,100hz (hertz), whichever is closer to the sample rate of the original file.

Content provided by https://www.facebook.com/help/videos/uploading
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H. Embedding Video in Powerpoint

You can choose from many types of audio and video files to embed or link to in your PowerPoint 2010
presentation.

Overview of embedding a video

With Microsoft PowerPoint 2010, you can now embed a video from a file directly into your presentation.

NOTES

PowerPoint will support QuickTime (.mov, .mp4) and Adobe Flash (.swf) files when you have installed the
QuickTime and Adobe Flash players.

There are some limitations when using Flash in PowerPoint 2010, including the inability to use special effects
(such as shadows, reflections, glow effects, soft edges, bevels, and 3-D rotation), the fade and trim capabilities,
and the ability to compress these files for easier sharing and distribution.

PowerPoint 2010 64-bit is not compatible with 32-bit versions of QuickTime or Flash. You must install a 64-bit
version of QuickTime or Flash, or a 32-bit version of PowerPoint 2010.

Embed a video from a file

In Normal view, click the slide in which you want to embed a video.
On the Insert tab, in the Media group, click the arrow under Video, and then click Video from file.
In the Insert Video dialog box, locate and click the video that you want to embed, and then click Insert.

TIP You can also click the Video icon in a content layout to insert a video.
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= Bear
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Favorite Links

y My Office Live Work...
), Public

Type: Windows Media Audio/Video file
Size: 2,66 MB
Desktop Length: 00:00:10

% Recent Places

J Recently Changed

Computer

Folders




Video Formats

Overview of audio and video files

The following tables show the audio and video file formats that you can use in PowerPoint 2010. If you do not
see a file format listed below, you can convert that file type to a supported file format by using programs,
utilities, or add-ins other than PowerPoint 2010 such as those listed below.

Microsoft Windows Media Encoder: Windows Media Encoder is a free program that makes some files
compatible with PowerPoint.

Windows Media Player: Windows Media Player is a digital media player and media library application used
for playing audio, video, and viewing images on personal computers running the Microsoft Windows operating
system, as well as on Pocket PC and Windows Mobile-based devices.

IMPORTANT Although your audio or video file may have the same file extension as one listed below, it may
not play correctly if the correct version of the codec is not installed, or if the file is not encoded in a format
that is recognized by your version of Microsoft Windows. For more information about the most common
codecs, including where to get them, see Using codecs or Encoding Audio and Video with Windows Media

Codecs.

Compatible audio file formats

NOTE Both iPod and Zune support the Advanced Audio Coding (AAC) file format. PowerPoint 2010 will support this file format
provided that the correct codec is installed. Examples of codecs for the AAC file format include the Apple QuickTime

player and ffDShow.

FILE FORMAT EXTENSION  MORE INFORMATION

AIFF Audio file .aiff Audio Interchange File Format This sound format originally was used on Apple and Silicon Graphics
(SGI) computers. These waveform files are stored in an 8-bit monaural (mono or one channel) format,
which is not compressed and can result in large files.

AU Audio file .au UNIX Audio  This file format typically is used to create sound files for UNIX computers or the Web.
MIDI file .mid or Musical Instrument Digital Interface  This is a standard format for the interchange of musical

.midi information between musical instruments, synthesizers, and computers.
MP3 Audio file  .mp3 MPEG Audio Layer 3 This is a sound file that has been compressed by using the MPEG Audio Layer

3 codec.

Windows .wav Wave Form This audio file format stores sounds as waveforms, which means that one minute of
Audio file sound can occupy as little as 644 kilobytes or as much as 27 megabytes of storage.
Windows .wma Windows Media Audio This is a sound file that has been compressed by using the Microsoft
Media Audio Windows Media Audio codec, a digital audio coding scheme developed by Microsoft that is used to

file distribute recorded music, usually over the Internet.
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Compatible video file formats

NOTE Videos in the .mp4, .mov, and .qt formats can be played in PowerPoint if the Apple QuickTime player is installed.

FILE FORMAT  EXTENSION MORE INFORMATION

Adobe Flash swf Flash Video This file format is generally used to deliver video over the Internet using the Adobe

Media Flash Player.

Windows .asf Advanced Streaming Format This file format stores synchronized multimedia data and can be used

Media file to stream audio and video content, images, and script commands over a network.

Windows .avi Audio Video Interleave This is a multimedia file format for storing sound and moving pictures in

Video file Microsoft Resource Interchange File Format (RIFF) format. It is one of the most common formats
because audio or video content that is compressed with a wide variety of codecs can be stored in an
.avi file.

Movie file .mpg or Moving Picture Experts Group This is an evolving set of standards for video and audio compression

.mpeg developed by the Moving Picture Experts Group. This file format was designed specifically for use with

Video-CD and CD-i media.

Windows .wmv Windows Media Video This file format compresses audio and video by using the Windows Media
Media Video Video codec, a tightly compressed format that requires a minimal amount of storage space on your
file computer's hard disk.

NOTE The third-party products discussed in this article are manufactured by vendors independent of Microsoft; we make no

warranty, implied or otherwise, regarding the performance or reliability of these products.



